
TOTAL LIBRARIAN PER YAMAHA SERIE ES 
 
 
Grazie di adoperare il Total Librarian per Yamaha serie ES. 
 
Questo è un programma che rappresenta la soluzione librarian completa per i sintetizzatori 
Yamaha della serie ES. Vengono supportati Motif ES, S90 ES, Motif Rack ES e MO6/MO8. È un 
librarian per Voices, Performances, Multi e Master e vi aiuterà ad organizzare in modo efficace 
la vostra collezione di suoni e setup. È anche un completo ambiente di modifica per le 
timbriche dal momento che si integra con tutti i diversi editor per gli strumenti della serie ES. 
 
Le funzioni principali sono: 

• Interfaccia utente facile da navigare simile ad Explorer. Le collezioni di banchi e patches 
vengono rappresentati come cartelle e le patches come files. 

• Supporta le Total Libraries che gestiscono banchi di Voices user normali, banchi di drum 
kits user, Voices PLG user*, Performances, Multi** e Master***. 

• Supporta Voice Libraries che gestiscono un numero illimitato di user Voices normali e 
drum kits. 

• Permette l’apertura multipla simultanea di files di libreria di qualsiasi tipo. 
• Legge ed importa i dati dai files nativi della serie ES di tipo “all” o “voice all” (W7A, 

W7V, W7E, S7A, S7V, S7E, M7A).  
• Per ogni patch supporta la modifica del nome, la selezione per categoria/sottocategoria 

e l’aggiunta di commenti. 
• Permette di ricercare le patches per nome. 
• Permette di ordinare le patches per nome, categoria; sottocategoria e commenti. 
• Supporta la funzione di copia ed incolla multipli all’interno della stessa libreria o tra 

diverse librerie. 
• Supporta il facile riordinamento delle patches attraverso il “drag and drop”. 
• Utilizza un sistema incorporato di verifica delle relazioni intercorrenti tra le varie 

patches. Quando vengono riorganizzate le patches, tutte quelle che da esse dipendono 
vengono automaticamente aggiornate (facendo riferimento alle nuove locazioni di 
memoria) per conservare l’integrità della libreria. In altre parole, se si copia una 
Performance costituita da quattro Voices, quando questa Performance verrà copiata da 
una libreria ed incollata in un’altra si porterà automaticamente dietro anche le quattro 
Voices che la costituiscono. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Le seguenti note sono valide per l’intero documento 
[*] solo Motif ES, S90 ES, Motif Rack ES 
[**] solo Motif Rack ES, S90 ES 
[***] solo Motif ES, S90 ES, MO6/8 
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1. Quick Start Guide – Guida di avvio veloce 
 

1. Set-up Connections – Impostazioe dei collegamenti 
Quando si avvia il Total Librarian per la prima volta, si dovrebbe fare click su Setup -
>[MIDI Setup] e selezionare le porte MIDI alle quali è connesso il vostro sintetizzatore. 
Premere [OK] e se sono state selezionate le porte corrette, nella barra di stato si vedrà un 
messaggio di conferma che dice ad es. “S90 ES connected”. In alternativa dal menù si può 
usare la funzione “Autoconnect” che proverà automaticamente a determinare quali sono le 
porte alle quali il vostro sintetizzatore è collegato! 
 
2. Create a New Library File – Creare un nuovo file di Libreria 
Il Total Librarian supporta due diversi tipi di file Libreria: 

o Total Library Files (*.all) 
Questi files sono in grado di contenere tutti i banchi user del vostro sintetizzatore. 
Essi supportano Voices User, drum kits User, Voices PLG user, Performances, 
Multi** e Master***. La loro capacità è limitata alla capacità di memoria del 
sintetizzatore perché sono state pensate per avere la stessa struttura. 
 

o Voice Library Files (*.vlib) 
Questi files sono in grado di contenere un numero illimitato di Voices normali e 
drum kits. Essi servono da deposito di Voices (Voices normali e drum kits) dal quale 
si possono scegliere le Voices che andranno inviate ai files di Total Librarian o 
direttamente al sintetizzatore. 

 
3. Fill the New Library File with Data – Importazione dei dati in un file di Libreria 

nuovo 
Dopo aver creato un nuovo file di libreria è possibile importare i dati da Motif ES, S90 ES, 
Motif Rack ES e MO6/MO8 o da file nativo (Menu: File -> Import Native File) oppure 
ricevere i dati direttamente dalla memoria del sintetizzatore (Menu: File -> Receive All). Se 
si lavora con un file di Total Library possono essere importati solamente i banchi user. I 
banchi preset possono essere importati in un file di Total Library ed in seguito possono 
essere copiati in posizioni specifiche del suddetto file. 
 
4. Manipulate your Data – Manipolazione dei dati 
Vedere i capitoli 2 e 3. 
 
5. Browse and Monitor Patches – Scorrere ed ascoltare le Patches 
Quando si ha un file di libreria aperto – contenente delle patches – è sempre possibile 
premere il tasto ‘enter’ e la patch selezionata verrà trasmessa all’edit buffer del 
sintetizzatore. Questa operazione viene effettuata per un puro ‘scopo di monitoraggio’ – 
permette di ascoltare la patch selezionata senza in realtà sovrascrivere la locazione di 
memoria interna del sintetizzatore. 
 
6. Send Data to the Synth or to a File – Inviare i dati al sintetizzatore o su file 
Dopo aver terminato di apportare le necessarie modifiche ad una libreria si possono salvare 
su file (Menu: File -> Save As) oppure si possono inviare direttamente al sintetizzatore se 
si sta lavorando con un file di Total Library (Menu: Edit -> Transmit All). 
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2. Working with Libraries - Lavorare con le Librerie 
 
In Total Librarian i file di Libreria hanno l’aspetto tipico dell’interfaccia familiare di Explorer. 
Sulla sinistra c’è una struttura a “directory” (cartelle) mentre sulla destra si trova una “file 
list” (elenco di file). Le “Cartelle” rappresentano i banchi del sintetizzatore o 
raggruppamenti di banchi ed i “files” rappresentano le patches contenute nella Libreria. Le 
Patches sono Normal Voices, PLG Voices*, Drum Kits, Performances, Multi** e Master*** 
 

 
 
La maggior parte dei comandi disponibili per la modifica è presente anche come voci di 
menù e verranno descritte in seguito. I comandi che non hanno un corrispettivo a livello di 
menù sono: 
 
Patch Editing – Modifica delle Patches 
È possibile modificare in modo veloce il nome della patch selezionata premendo il tasto F2. 
Se si fa click sul campo patch category (categoria di patch) appare un menù drop down 
(menù a discesa) che permette di associare subito la categoria e la sottocategoria della 
patch. 
Se si fa click sul campo di commento alla patch sarà possibile modificare sul posto il 
commento associato alla patch selezionata. 
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Patch Sorting – Ordinamento delle Patches 
Se si fa click sull’intestazione delle colonna di una patch list, le patches verranno ordinate a 
seconda di quel tipo di colonna. Questo significa che il librarian permette l’ordinamento 
delle patches per nome, per categoria/sottocategoria e per commento. Si prega di tenere in 
considerazione che ordinare le patches di un banco non va modificare la memoria interna 
del sintetizzatore. Bisogna usare il comando “Transmit” per inviare al sintetizzatore le 
patches riordinate. 
 
Drag ‘n’ Drop: Patch Reordering Made Easy – Riordino facilitato delle Patches 
tramite Drag ‘n’ Drop 
Questa è una potente funzione di Total Librarian che rende il riordino delle patches veloce 
come un batter d’occhio. Avete mai avuto difficoltà a riorganizzare l’ordine dei vostri 
Master, delle vostre Performances ecc.? Scegliete semplicemente le patches che desiderate 
spostare (sono permesse anche le selezioni multiple) e spostatele nella locazione 
desiderata. Salvate il file di libreria ed inviate le patches al sintetizzatore. 
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3. Working with Editors – Lavorare con gli Editor 
 
Total Librarian è l’applicazione host (di supporto) per tutti gli editor in versione plugin della 
serie ES. Si può accedere agli editor installati sia attraverso il Menu [Editors] che dalla Toolbar 
(barra degli strumenti) degli Editor. Se il menù di un editor appare di colore grigio significa che 
non è stato correttamente installato nel vostro sistema e bisogna nuovamente ripetere la 
procedura di installazione. 
 
Si può tenere aperto un solo editor alla volta. Se Total Librarian è stato correttamente 
connesso al sintetizzatore, l’editor che avete scelto si collega automaticamente tramite la 
connessione MIDI del Total Librarian (non c’è bisogno di configurare porte MIDI specifiche per 
la versione plugin degli editor – queste sono necessarie solo per la versione degli editor che 
funzionano in modo autonomo). A seguito del collegamento l’editor plugin non richiede l’invio 
di dati da parte del sintetizzatore – attende solamente che i dati vengano inviati dal Total 
Librarian al buffer di edit del sintetizzatore. 
 
Example Editor Usage – Esempio di uso dell’Editor 
 
Ipotizziamo che abbiate aperto un file di Total Librarian che contiene alcune Performances. Si 
può quindi usare il plugin di Editor delle Performance integrato per modificare la Performances 
contenute nel file. La procedura è piuttosto immediata. Selezionate la Performance che volete 
modifiare ed inviatela al buffer di edit del sintetizzatore premendo il tasto Enter (o 
selezionando Patch->Send to Edit Buffer dal menù principale oppure dal menù contestuale 
della patch). Fatto! I dati della patch vengono inviati al buffer di edit del sintetizzatore e 
l’editor viene sincronizzato leggendoli e mostrandoli automaticamente. 
 
In seguito si possono modificare i parametri della Performance esattamente come si farebbe 
con la versione del Performance Editor che funziona in modo autonomo. 
 
Una volta che si è terminato di modificare la Performance è possibile rinviarla al file Total 
Library premendo Ctrl+click sul tasto sinistro del mouse (o selezionando Patch -> Receive 
from Edit Buffer dal menù principale oppure dal menù contestuale della patch). Naturalmente 
si può anche salvare la Performance in un’altra locazione di memoria della Total Library. 
Salvate il file della Total Library e la Performance appena modificata è salva! 
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4. Menu Commands – Comandi del Menù 
 
File 
 

• New 
Crea un nuovo documento (o un file nuovo di Total Library oppure un file nuovo di Voice 
Library) 
 

• Open 
Con questo comando si possono aprire un file di Total Library o un file di Voice Library 
salvati in precedenza. Si prega di tenere in considerazione che è possibile aprire allo 
stesso tempo più file di libreria. 
 

• Save 
Con questo comando si può salvare su file la libreria attualmente modificata. 
 

• Save As 
Con questo comando si può salvare su file e con altro nome la libreria attualmente 
modificata. 
 

• Close 
Chiude la libreria attiva. 
 

• Close All 
Chiude tutte le librerie attive. 
 

• Import Native File 
Con questo comando si possono importare le patches (voices, performances, multi**, 
master) contenuti in un file Motif nativo “all” o “voice all” (W7A, W7V, W7E, S7A, S7V, 
S7E, M7A) nel documento di libreria correntemente attiva. Esso funziona sia per i 
formati Total Library che Voice Library. Naturalmente nelle librerie di Voices verranno 
importate solo Voices normali e drum kits. 
 

• Export Patches Names 
Con questo comando si può salvare su file di testo una lista dei nomi delle patches. I 
dati esportati possono essere utilizzati per creare delle stampe dei vostri elenchi di 
timbri per le esibizioni o semplicemente aiutarvi a tenere traccia di cosa è contenuto nei 
vostri files di libreria. 
 

• Export Instrument Definition File 
Dalla Total Library correntemente aperta crea un file “Cakewalk Instrument Definition” 
inserendo i nomi delle Voices user a seconda di quelle che sono contenute nel file di 
libreria.  
 

• Recent Files 
Richiama velocemente uno tra gli otto files che sono stati aperti (o modificati) per 
ultimi. 
 

• Exit 
Uscita dal programma ;-) 
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Edit 
 

• Undo 
Il comando di Undo annulla l’ultima operazione di modifica apportata al file attivo di 
libreria. 
 

• Redo 
Il comando Redo riapplica l’azione o il comando sul quale è stato usato il comando 
Undo. 
 

• Transmit All 
Questo comando permette di trasmettere al sintetizzatore tutti i banchi del file di 
libreria (banchi di Voices user normali, drum kits user, Voices PLG user, Performances, 
Multi* e Master). Ogni volta si possono scegliere quali banchi si vogliono davvero 
trasmettere. Si prega di notare che questo comando funziona solo per i file di Total 
Library perché solamente questi files hanno una struttura analoga a quella della 
memoria interna del sintetizzatore. 

 
• Receive All 

Questo comando funziona per entrambi i formati di libreria. Se il file di libreria 
correntemente attivo e un file di Total Library, quest’ultimo può ricevere dal 
sintetizzatore tutti i banchi user (banchi di Voices user normali, drum kits user, Voices 
PLG user, Performances, Multi* e Master). Se invece il file di libreria correntemente 
attivo e un file di Voice Library, quest’ultimo può ricevere solo Voices user normali e 
drum kits user. Ogni volta si possono scegliere quali banchi davvero ricevere. 
 

• Remove Duplicates 
Se sono state importate molte patches provenienti da sorgenti diverse sarà facile che il 
vostro file di libreria ne contenga di identiche. Questa funzione di utilità le cerca e le 
rimuove dalla libreria. Alla fine del processo di ricerca viene visualizzato un rapporto. 
 

• Select All 
Con questo comando è possibile selezionare tutte le patches contenute in un banco 
oppure una collezione di patches. 
 

• Invert Selection 
Inverte la selezione corrente – disseleziona le patches selezionate e seleziona quelle 
non selezionate. 
 

• Patch 
Vedere il capitolo 4 (Patch Menu Commands). 
 

• Search 
È possibile cercare nella vostra libreria una determinata patch fornendo il suo nome od 
una parte di esso. Quando si fa doppio click sul risultato della ricerca, la patch che si 
stava cercando viene selezionata nel file della libreria attiva. 
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View 
 

• Up Folder 
Uno dei più grandi benefici dati dai file di libreria è che visualizzani i loro dati con 
un’interfaccia utente simile ad Explorer. Questo comando serve a spostarsi nella cartella 
gerarchicamente posta ad un livello superiore, che potrebbe essere una collezione di 
banchi oppure una collezione di altre cartelle. 
 

• Editors Toolbar 
Mostra o nasconde la barra degli strumenti che contiene le icone degli editor. 
 

Editors 
 

• Voice Editor 
Carica il plugin Voice Editor. 
 

• Drum Kit Editor 
Carica il plugin Drum Kit Editor. 
 

• Performance Editor 
Carica il plugin Performance Editor. 
 

• Mix Editor 
Carica il plugin Mix Editor. 
 

• Master Editor*** 
Carica il plugin Master Editor. 

 
Setup 
 

• Midi Setup 
In questa finestra si possono selezionare le porte MIDI-in e MIDI-out a cui collegare il 
vostro sintetizzatore. È possibile anche definire l’intervallo (espresso in millisecondi) da 
aggiungere qualora vengano inviati al sintetizzatore multipli messaggi esclusivi di 
sistema. In fine, è possibile selezionare ulteriori tre porte ausiliarie: due porte MIDI-in 
aggiuntive alle quali collegare tastiere MIDI o altre tipologie di controller (cosicché sia 
possibile controllare il Master Editor utilizzando i suddetti controller aggiuntivi che 
potreste avere nel vostro set-up) ed una porta MIDI-out aggiuntiva che replicherà i dati 
in ingresso (funzionalità MIDI Thru) 
 

• Autoconnect 
Invece di definire manualmente le porte MIDI alle quali il vostro sintetizzatore è 
collegato è possibile usare questo comando affinché il programma riconosca le porte in 
modo automatico. In seguito si potrà aprire la finestra di Midi Setup per vedere quali 
porte sono state selezionate. 
 

• Preferences 
Permette di configurare alcuni parametri di base dell’applicazione a seconda delle 
proprie esigenze. 
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Startup Options: 
Si può scegliere che cosa si desideri accada 
quando si carica Total Librarian. Si può fare in 
modo che carichi un file vuoto di Total Library, 
una libreria vuota di Voice, il file di libreria 
utilizzato per ultimo oppure non faccia alcunché. 
 
Dependency Options: 
Total Librarian permette la verifica ed il 
mantenimento delle relazioni tra le patches. 
Questo significa che è in grado di sapere se una 
patch usa altre patches oppure quando questa 
viene usata da altre patches. 
 

 
Secondo l’architettura dei sintetizzatori della serie ES: 
o Le Performances ed i Multi possono far uso delle Voices User. 
o I Master possono far uso delle Voices User, delle Performances e dei Multi. 
Questo significa che: 
o Le Voices User possono venire usate dalle Performances, dai Multi e dai Master. 
o Le Performances ed i Multi possono venire usati dai Master. 
Nella terminologia di Total Librarian quando una patch usa un’altra patch viene 
chiamata patch “genitore” e quando invece viene utilizzata da un’altra patch viene 
chiamata patch “figlia”. 
 
Enable Dependency Coloring 
Con questo comando è possibile attivare la colorazione delle patches a seconda del loro 
stato di interrelazione con le altre patches. Per definizione, quando una patch è figlia 
sarà colorata di rosso, quando è genitore sarà colorata di blu e quando è sia figlia che 
genitore sarà di color porpora. È possibile ridefinire questi colori a proprio piacimento. 

 
Paste Child Patches 
Quando si incolla una patch Total Librarian può incollare al posto vostro anche le sue 
patches figlie (patches che sono utilizzate da quella patch e che appartengono alla 
libreria). In questa sede si può decidere se si vuole che questo accada 
automaticamente, se si desidera che Total Librarian chieda conferma prima di incollare 
queste patches aggiuntive, oppure si può semplicemente disabilitare questa funzione. 

 
Help 
 

• Manual 
Visualizza questo documento. 
 

• About 
Visualizza informazioni utili in merito al programma. 
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5. Patch Menu Commands – Comandi del Menu Patch 
 

 

Se dal menu principale si seleziona Edit -> Patch oppure 
si fa click con il tasto destro su una patch, viene 
visualizzato il menù Patch. 

 
Patch Menu 
 

• Send to Edit Buffer 
È possibile inviare la patch selezionata al buffer di edit del sintetizzatore solo per 
ascoltarla – non apporta alcun cambiamento alla memoria interna del sintetizzatore. Se 
l’editor corrispondente è aperto riceverà automaticamente i dati inviati. 
 

• Receive from Edit Buffer 
È possibile usare questo comando per ricevere i dati modificati dal sintetizzatore al file 
di librarian. Con questo comando si possono ricevere i dati del buffer di edit nella patch 
attualmente selezionata che si trova nel file di libreria. 
 

• Transmit 
Questo comando esiste solo nelle patches dei files di Total Library. Con questo comando 
si possono trasferire le patches selezionate nella loro posizione corrispondente della 
memoria del sintetizzatore. La memoria del sintetizzatore viene sovrascritta. 
 

• Receive 
Questo comando esiste solo nelle patches dei files di Total Library. Le patches 
correntemente selezionate nella libreria acquisiscono i dati dalle corrispondenti posizioni 
di memoria del sintetizzatore. 
 

• Transmit Child Patches 
Questo comando esiste solo nelle patches dei files di Total Library dal momento che 
viene usato con Performances e Master. Si possono trasmettere le patches utilizzate 
dalle Performances o Master selezionati (patches figlie) per assicurare l’integrità dei dati 
del file di Total Library. 
 

• Receive Child Patches 
Questo comando esiste solo nelle patches dei files di Total Library dal momento che 
viene usato con Performances e Master. Si possono richiedere le patches utilizzate dalle 
Performances o Master selezionati (patches figlie) per assicurare l’integrità dei dati del 
file di Total Library. 
 

• Send Program Change 
Questo comando invia al sintetizzatore un program change cosicché la patch selezionata 
nella libreria venga ugualmente selezionata anche nel sintetizzatore. 
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• Copy 

Questo comando copia le patches selezionate nella clipboard. 
 

• Paste 
Con questo comando si possono incollare le patches copiate in precedenza. Se si stanno 
incollando in un file di Total Library, le patches nella clipboard sovrascriveranno le 
patches selezionate nel file. Se non è stata selezionata alcuna patch comincerà 
dall’inizio del corrente banco. Se si sta incollando un file di Voice Library, le nuove 
Voices verranno inserite prima delle patches selezionate. Se non è stata selezionata 
alcuna patch, le nuove patches verranno aggiunte alla fine della lista. 
 

• Swap 
Questo comando è disponibile solo nei files di Total Library. Aiuta a scambiare la 
posizione delle patches tra i diversi banchi dello stesso file mantenendo intatte le 
interrelazioni. Selezionare le patches che si desiderano spostare e copiarle nella 
clipboard tramite il comando Copy. Poi fare click con il tasto destro sulla posizione di 
destinazione dove si desidera inviare le patches (ad es. in un banco diverso) e 
selezionare il comando Swap. Le patches copiate verranno incollate nella nuova 
posizione e le patches esistenti nella nuova posizione verranno spostate nella posizione 
originale delle patches copiate! 
 

• Initialize 
Questo comando inizializza le patches selezionate riportandole al loro valore di default. 
 

• Rename 
Questo comando permette di introdurre un nuovo nome per la patch selezionata. 
 

• Delete 
Questo comando cancella le patches selezionate. Per i files di Total Library questo 
comando svuota le loro locazioni. Per le Voices Libraries (librerie di Voices) questo 
comando cancella definitivamente le Voices dal file. 
 

• Remove Duplicates 
Questo comando, tra quelle selezionate, esegue la rimozione delle patches duplicate 
(Edit->Remove Duplicated). Rimuove gli inserimenti duplicati di patches e visualizza un 
rapporto di quello che ha fatto. 
 

• Properties 

 

Con questo comando si possono modificare le proprietà 
delle patches selezionate. 
Le proprietà delle patches sono: 

o Name (Nome): nome della patch 
o Category: categoria e sottocategoria della patch 

(non attiva per Multi e Master) 
o Comment (Commenti): una breve descrizione che 

permetta di riconoscere facilmente la patch. 
Se sono state selezionate più patches sarà possibile 
modificare solo alcuni campi e lasciarne altri immutati. 
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Contatti 
 
Per qualunque suggerimento, commenti, richieste o segnalazione errori, non abbiate esitazioni 
a contattarmi (in inglese) al seguente indirizzo email: 
 
  info@jmelas.gr 
 
Per aggiornamenti e novità sul programma si prega di visitare il seguente sito: 
 
  http://www.jmelas.gr/motif 
 
Spero che con Total Librarian non solo vi divertiate ma – soprattutto – ve la spassiate con le 
vostre collezioni di suoni. 
 

Cordiali saluti, 
John Melas 

 
 
---------------------------------------------------------------------------------------------------------- 
 
Traduzione ed integrazioni a cura di Michele Tornatore © 2010 – wavesequence@gmail.com - 
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